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LESSON 1 -  
WORKING WITH DRAWING OBJECTS  

CREATING A DRAWING OBJECT 

 Discussion 
You can enhance a document by drawing an object such as a rectangle, oval, line, arrow, or polygon directly in 
it. For example, arrows can be used to point to important items, rectangles or ovals can be used to draw 
attention to specific items, and lines can be used to divide different items in a document. Drawing objects are 
created using the buttons on the Drawing toolbar. 
 
Enclosed drawing objects (such as rectangles or ovals) are filled by default. Filled objects are opaque and 
contain patterns and/or colors. If filled objects are drawn on top of text in a document, the text is hidden. You 
can, however, remove an object’s fill. Unfilled objects allow the text behind them to be seen. 
 
As soon as you click a drawing object button on the Drawing toolbar, Word inserts a drawing canvas. The 
drawing canvas makes it easier to create and maintain complex drawings. All objects drawn within the 
confines of the drawing canvas are kept together as one unit. Although drawing objects are stored permanently 
on the drawing canvas, you can drag objects on or off the canvas as desired; Word allows objects to be stored 
in the document text as well. 
 
When you are drawing an object, the mouse pointer changes into a crosshair. The center of the crosshair 
represents the outer border of the object. In addition, Word switches to Print Layout view as soon as you 
click a drawing object button. 
 
Drawing objects can be moved or copied to any location in a document, and any objects stored on a drawing 
canvas are moved or copied as one unit. Once drawn, objects can be modified to change their shape, size, 
color, fill, and pattern, as well as a number of other attributes. 
 

  

 
To draw a square or a circle, click either the Rectangle button or the Oval button respectively and 
hold the [Shift] key as you drag. Clicking in the document after selecting a drawing object button 
inserts the object in a predefined size. 

  

 
To draw more than one object of the same type, double-click the applicable drawing object button. 
After you have drawn the desired number of objects, you can press the [Esc] key or click the 
applicable drawing object button again to deactivate it. 

  

 
Word provides a grid of horizontal and vertical lines to help you create and align objects. From the 
Drawing toolbar, select the Draw menu, the Grid command, and the Display gridlines on screen 
option; then enter the desired amount of spacing between the vertical and horizontal grid lines. 
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 Procedures 

1. Switch to Print Layout view. 

2. Position the insertion point where you want the drawing object to appear. 

3. Click the Drawing button  on the Standard toolbar. 

4. Click the applicable drawing object button on the Drawing toolbar. 

5. Drag in the drawing canvas to position and size the object as desired. 

 

SELECTING FILLED AND UNFILLED OBJECTS 

 Discussion 
Before you can modify a drawing object, you must select it. When an object is selected, white sizing handles 
and a green rotation handle appear around it. Any formatting commands you perform affect only the selected 
object. An object remains selected until you select another object or click elsewhere in the document. 
 
Different methods are used to select filled and unfilled objects. Since an unfilled object is empty, you must 
click its border in order to select it. You can, however, click anywhere in a filled object to select it. 
 

  

 
To select more than one drawing object, click the Select Objects button on the Drawing toolbar and 
drag to select all adjacent objects, or hold the [Shift] key and click each object you want to select. 

  

 
When you select a graphic image that has been inserted from a file, black sizing handles appear 
around it. 

  
 

 Procedures 

1. Switch to Print Layout view. 

2. Click in any filled object to select it. 

3. Click the border of any unfilled object to select it. 

MOVING AN OBJECT 

 Discussion 
After you have created an object, you can move it to a different location in the document by dragging it to the 
desired location. Moving objects is a good way to reposition them so that they better enhance the text. 
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The mouse pointer must appear with a black, four-headed arrow in order to move an object. 
 

  

 
If you cannot move an object, right-click it and select the Format AutoShape or Format Picture 
command. In the Format dialog box, select the Layout page and then select any wrapping style other 
than the In line with text option. 

  

 
To nudge an object, select the object and use the [Up], [Down], [Right], and [Left] arrow keys. 
Holding the [Ctrl] key while you use the arrow keys moves the object in smaller increments. 

  

 
To rotate an object, drag its green, rotate handle. To anchor an object by the center selection handle 
along its bottom edge, hold the [Ctrl] key as you drag. 

  
 

 Procedures 

1. Switch to Print Layout view. 

2. Drag the object you want to move to the desired location. 

 

USING THE DRAWING CANVAS 

 Discussion 
The drawing canvas acts as a frame in which you can create and arrange multiple drawing objects. 
 
You can use the buttons on the Drawing Canvas toolbar to change the size of the drawing canvas. The Fit 
button resizes the canvas tightly around the objects within it. Conversely, the Expand button enlarges the 
canvas, creating more space between the  border of the drawing canvas and the objects within it. Each time 
you click the Expand button, the canvas gets larger. These options only change the size of the drawing canvas; 
the size of the drawing objects within it are not affected. 
 
The drawing canvas helps keep the objects in a complex drawing together and allows you to move and resize 
all the objects as one unit. Using the Scale Drawing button, you can resize all the objects within the drawing 
canvas at the same time. When you move the drawing canvas, all the objects remain in their relative positions 
and move with the canvas. However, you cannot move the drawing canvas if the In Line With Text option is 
enabled from the Text Wrapping button on the Drawing Canvas toolbar. Selecting another text wrapping 
option allows you to freely move the drawing canvas. 
 

  

 
The options on the Text Wrapping menu are not available if an object is selected in the drawing 
canvas. To deselect all objects, click in any blank area of the drawing canvas. 

  

 
To display the Drawing Canvas toolbar, right-click in the canvas and select the Show Drawing 
Canvas Toolbar. 
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You can move and resize multiple objects as one object without using the drawing canvas by 
grouping them. Select all the objects you want to group, and then select the Group command from 
the Draw menu on the Drawing toolbar. 

  
 

 Procedures 

1. Select any object in the drawing canvas. 

2. Click the  Fit button on the Drawing Canvas toolbar to fit the drawing canvas to its contents. 

3. Select the  Expand button on the Drawing Canvas toolbar to enlarge the drawing canvas as desired. 

4. Select the  Scale Drawing button on the Drawing Canvas toolbar to resize the contents in the drawing 
canvas. 

5. Drag a sizing handle as desired to resize the objects.  

6. Select the  Scale Drawing button on the Drawing Canvas toolbar to disable scaling. 

7. Click the Text Wrapping button  on the Drawing Canvas toolbar. 

8. Select the desired text wrapping option. 

9. Drag the frame of the drawing canvas to move the objects to the desired position. 

 

DRAWING WITHOUT THE DRAWING CANVAS 

 Discussion 
There are times when it may be more efficient to draw an object without using the drawing canvas. The 
drawing canvas was designed to help control the layout of text and diagrams in documents, as well as to 
manage multiple objects. If you are inserting only one object, you can do this without the drawing canvas. 
 
To draw a single object without the drawing canvas, you can either draw the object outside of the drawing 
canvas, or you can press the [Esc] key when the canvas first appears, before you draw the object. This action 
removes the drawing canvas from the document, but only for the current instance. If you subsequently click a 
drawing object button or select an AutoShape from the Drawing toolbar, the drawing canvas will again 
appear. 
 
In addition, pressing the [Esc] key hides the drawing canvas for an existing drawing, but does not remove it. 
When you reselect the object, the drawing canvas reappears. 
 
You can permanently disable the drawing canvas for all new drawings. If you do so, the drawing canvas no 
longer appears when you click a drawing object button or select an AutoShape from the Drawing toolbar. 
However, existing drawing canvases are not affected. 
 

  



 

University Information Technologies Page 5 
 

 
To disable the Drawing Canvas feature, select the Tools menu and the Options command. On the 
General tab in the Options dialog box, deselect the Automatically create drawing canvas when 
inserting AutoShapes option. 

  

 
You can drag an object off the drawing canvas and move it to the desired position. You can then 
select the drawing canvas and press the [Delete] key to delete it. 

  
 

  

 
If you delete a drawing canvas with objects still in it, the objects are also deleted. 

  
 

 Procedures 

1. Select the desired drawing button on the Drawing toolbar. 

2. Press [Esc]. 

3. Drag to draw the desired object. 

 

DRAWING A LINE 

 Discussion 
Lines can be used to separate areas of a document. For example, you can add a line between different items in 
a document. Lines can be drawn at various angles and positions. Drawn lines, as opposed to borders, can be 
moved and sized as desired. 
 
When you draw a line, the mouse pointer changes into a crosshair. The center of the crosshair is the point at 
which the line is drawn. 
 

  

 
To draw a straight line, hold the [Shift] key as you drag. If you move the mouse pointer up or down, 
the angle of the line will change in 15-degree increments. 

  

 Procedures 

1. Switch to Print Layout view and display the Drawing toolbar. 

2. Click the Line button  on the Drawing toolbar. 

3. Press [Esc] to remove the drawing canvas, if desired. 

4. Drag from the beginning to the endpoint of the line. 
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CHANGING AND REMOVING THE FILL COLOR 

 Discussion 
You can change the fill color of an object at any time. Changing the fill color enhances the appearance of 
objects. If the fill color of an object hides text in a document, you can select the No Fill option for that object 
in order to view the text. 
 
The Fill Color button consists of two components. The Fill Color button displays the currently selected color. 
To apply the currently selected color to another object, you only have to select the object and click the Fill 
Color button. You can also use the Fill Color list to select the desired color from the color palette. 

 Procedures 

1. Switch to Print Layout view and display the Drawing toolbar. 

2. Select the object containing the fill color you want to change. 

3. Click the arrow on the Fill Color button  on the Drawing toolbar. 

4. Select the desired fill color. 

 

FORMATTING LINES 

 Discussion 
You can format lines by changing the line style, color, and dash style. In an enclosed object, the line is the 
border around the object. In an open object, such as a line or an arrow, the line is the object itself. 
 
You can change the style of any existing line. Line styles can be used to change the thickness of a line or to 
create double and triple lines. For example, to dramatically separate items in a document, you can increase the 
width of the line that separates them.  
 
In addition, you can change an existing line to a dash style. Dash styles break the line into dots or dashes. 
Dashed lines can help to enhance the appearance of a document or to identify a means of separation. 
 
You can also change the line color of a drawing object. Changing the line color can enhance the appearance of 
the object. For example, if you are creating a logo, changing the line color can help distinguish the border of 
the logo. 
 
The Line Color button consists of two components. The Line Color button displays the currently selected 
color. To apply the currently selected color to another object, you only have to select the object and click the 
Line Color button. In addition, you can use the Line Color list to select a different color from the color 
palette. 
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You can use the Arrow Style button on the Drawing toolbar to change a line to an arrow by 
selecting one of the available arrow styles in the Arrow Style list. You can also use the Arrow 
button on the Drawing toolbar to draw an arrow. 

  
 

 Procedures 

1. Switch to Print Layout view and display the Drawing toolbar. 

2. Select the object containing the line you want to format. 

3. To change the line style, click the Line Style button  on the Drawing toolbar. 

4. Select the desired line style. 

5. To change the line color, click the arrow on the Line Color button  on the Drawing toolbar. 

6. Select the desired line color. 

7. To change the dash style, click the Dash Style button  on the Drawing toolbar. 

8. Select the desired dash style. 

RESIZING AN OBJECT 

 Discussion 
You may want to resize an object or graphic image so that it fits better in a document. Drawing objects and 
graphic images can easily be resized using their sizing handles. If you drag a middle sizing handle on any side 
of an object, you change the size in that one direction only. If you drag any sizing handle at the corner of an 
object, however, you change the size in two directions at once. 
 

 
The mouse pointer must be a double-headed arrow to size a graphic image or drawn object. 

  

 
You must be in Print Preview, Print Layout, or Web Layout view to see a drawing object. 

  

 Procedures 

1. Switch to Print Layout view. 

2. Select the object you want to resize. 

3. Drag any sizing handle as desired to increase or decrease the size of the object. 
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ADDING A 3-D EFFECT 

 Discussion 
If you want an object to appear three-dimensional, you can add a 3-D effect. For example, if you are creating a 
logo, a 3-D effect makes the object stand out from the page. You can select from a variety of 3-D effects. 
 
Different effects can be added to a 3-D object using the 3-D Settings command on the 3-D Style palette. You 
can apply various depth, direction, lighting, surface, and color settings. You can also tilt 3-D objects up, down, 
left, or right. 
 
Depending on the object selected, certain options may not be available. 
 

  

 
You can use the Shadow Style button on the Drawing toolbar to add a shadow effect to an object. 
An object can have either a shadow or a 3-D effect, but not both. 

  

 
You cannot assign a line color to a filled, 3-D object, but you can change the fill color. 

  

 Procedures 

1. Switch to Print Layout view and display the Drawing toolbar. 

2. Select the object to which you want to add a 3-D effect. 

3. Click the 3-D Style button  on the Drawing toolbar. 

4. Select the desired 3-D style. 

 

LAYERING TEXT AND OBJECTS 

 Discussion 
Word arranges objects in individual layers or stacks. You can use commands available on the Order submenu 
of the Draw menu on the Drawing toolbar to arrange the layers on which text and drawing objects (such as 
ovals, rectangles, lines, and text boxes) appear. For example, if text is hidden behind one or more drawing 
objects, you can display it by selecting the object(s) and using Send Behind Text command. 
 
When you use the drawing canvas to insert objects, you can specify how you want text to be wrapped around 
the drawing canvas with the Text Wrapping button on the Drawing Canvas toolbar. You cannot select text 
wrapping options for an individual object in the drawing canvas. However, you can use the Order submenu to 
layer individual objects in the drawing canvas. 
 
By default, when you draw an object, it is placed in the top layer of the stack. 
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You can also access the Order submenu by right-clicking an object and selecting the Order 
command. 

  

 Procedures 

1. Select the drawing object you want to layer. 

2. Select the Draw menu on the Drawing toolbar. 

3. Point to the Order command. 

4. Select the desired command. 

DELETING AN OBJECT 

 Discussion 
If you no longer need it, you can delete a graphic image, an object, or an entire drawing canvas from a 
document. If you accidentally delete a graphic image, an object, or a drawing canvas, you can use the Undo 
feature to restore it to the document. 
 
If you delete a drawing canvas, all of the objects within it are also deleted. 
 

 Procedures 

1. Switch to Print Layout view. 

2. Select the object you want to delete. 

3. Press [Delete]. 

 



 

 

LESSON 2 -  
INSERTING GRAPHICS  

 Discussion 
You can include clip art images in a Word document. Clip art images can enhance a document by depicting an 
idea that may be difficult to describe or by making the document more visually appealing. You can use the 
Insert Clip Art task pane to access the Clip Organizer. 
 
To find a clip, enter a word related to the type of clip art you want to insert in the Search text box. Words used 
in a search are called keywords. If you want to insert a clip into a document, but you are not sure which one 
you want to add, you can use a keyword search for clips. For example, if your document deals with sporting 
goods, you can use the keyword sports to search the Clip Organizer; any clip art pertaining to sports will 
appear. 
 
You can limit searches to a specific type of collection or media file by selecting the corresponding option 
under the Other Search Options area. If you have changed search criteria, but have not yet performed the 
search, you can use the Restore button to return to the previous settings. 
 
After entering your search criteria and clicking the Search button, thumbnails of the clip art found based on 
the search criteria appear in the Results box. You can expand the Results box by clicking the button above the 
first image. Clicking the button again returns the Results box to its previous size. 
 
Pointing to a clip displays a ScreenTip with the keywords related to that image, its size in pixels, its file size, 
and its graphic format. Clicking directly on a clip inserts it into your document at the insertion point. You can 
use the list of options that appears when you right-click a clip or click its drop-down arrow to copy or delete 
the clip, edit the clip keywords, find clips with a similar style, or view the clip properties. 
 
If the list of found clips does not suit your needs, you can use the Modify button to modify the search or to 
create a new one. 
 

  

 
You can also open the Insert Clip Art task pane by selecting the Insert menu, pointing to the 
Picture command, and then selecting the Clip Art command. 

  

 
If you know the location of the clip art image you want to insert, you can select the location 
from the Search in list on the Insert Clip Art task pane. 

  

 
Keywords are editable; you can use the Preview/Properties dialog box to add keywords to or 
remove keywords from a clip, if desired. You can also add clips to the Clip Organizer, if 
desired. 
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 Procedures 

1. Position the insertion point where you want the clip art image to appear. 

2. Click the Insert Clip Art button  on the Drawing toolbar. 

3. If necessary, select Now in the Add Clips to Organizer message box to catalog the clips. 

4. Select the Search text box. 

5. Type the desired keyword. 

6. To limit the search, click the Search in arrow. 

7. Click options as desired to select the collections you want to search or deselect the collections you do not 
want to search. 

8. Click the plus sign next to a collection to expand its contents. 

9. Click options as desired to select the collections you want to search or deselect the collections you do not 
want to search. 

10. Press [Esc]. 

11. To limit what to search, click the Results should be arrow. 

12. Click the plus sign next to any media type to expand its contents. 

13. Click options as desired to select media you want to search or deselect media you do not want to search. 

14. Press [Esc]. 

15. Select the Search button. 

16. Click any clip to insert it. 

17. Select Modify to change the search criteria or click the Close button to close the Insert Clip Art task pane. 

INSERTING A PICTURE 

 Discussion 
In addition to clip art, you can insert a picture from an existing graphic file into a Word document. Pictures can 
include scanned images, photographs, and drawn objects saved as files. Before inserting a picture, you can 
preview it to verify that it is the one you want. 
 
A picture can float over the text, or it can be inline (that is, positioned at the insertion point). If a picture floats 
over the text, it appears on the line above the insertion point when inserted. You can, however, move the 
picture as desired; the surrounding text will wrap around it as needed. If you insert a picture inline, you can 
drag and drop the graphic at the desired document location. 
 
The Picture toolbar appears as soon as you select a picture in the document and closes when you deselect the 
picture. 
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You can also insert a picture from a file by selecting the Insert menu, pointing to the Picture 
command, and selecting the From File command. 

  

 
If you close the Picture toolbar while a picture is selected, it does not automatically appear again 
when you select the same or another picture. You can display the Picture toolbar by right-clicking 
any toolbar and selecting the Picture command. 

  
 

 Procedures 

1. Position the insertion point in the document where you want the picture to appear. 

2. Click the Insert Picture button  on the Drawing toolbar. 

3. Select the Look in list. 

4. Select the drive containing the picture file you want to insert. 

5. Open the folder containing the picture file you want to insert. 

6. Select the picture file you want to insert. 

7. Select Insert. 

FORMATTING PICTURES 

 Discussion 
Although pictures are inserted with default settings, you can use the Format Picture dialog box to change these 
settings at any time. You can change the size, alignment, fill color, and text wrapping style for inserted 
graphics. 
 
The text wrapping style of a graphic determines whether or not you can drag the object independently of the 
text in which it is positioned. The In line with text option keeps the graphic image within the document text. 
To be able to freely move an object on the page, you may have to select another text wrapping style. 
 

  

 
You can also open the Format Picture dialog box by clicking the Format Picture button on the 
Picture toolbar. 

  
 

 Procedures 

1. Switch to Print Layout view, if necessary. 

2. Right-click the picture with the formatting you want to change. 

3. Select the Format Picture command. 
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4. Select the desired tab. 

5. Select the desired options. 

6. Select OK. 

CREATING WORDART OBJECTS 

 Discussion 
You can use WordArt to create a graphic text object. Graphic text objects can be used to add emphasis to 
company logos, text advertisements, and newsletters. 
 
WordArt is an application that can run only within a companion program (such as Word); it cannot run 
independently. As a result, WordArt cannot create its own files. Each object created in WordArt becomes a 
part of the Word document in which it is embedded. 
 
To create a WordArt text object, you start WordArt, select a WordArt style, and then type and format the 
WordArt text. 
 
Once a WordArt object has been embedded in a document, you must open WordArt to make changes to the 
text and/or formatting. You can use tools available on the WordArt toolbar to format the WordArt object. 
 

  

 
You can create multiple lines in a WordArt object by pressing the [Enter] key as needed. 

  

 
Since WordArt creates a graphic object, any formatting you apply affects the entire WordArt 
object. Consequently, you do not need to select the WordArt text in the Edit WordArt Text 
dialog box before applying formatting. 

  
 

 Procedures 

1. Position the insertion point where you want to insert the WordArt text. 

2. Click the Insert WordArt button  on the Drawing toolbar. 

3. Select the desired WordArt style.  

4. Select OK. 

5. Type the desired WordArt text. 

6. Format the WordArt text as desired. 

7. Select OK. 
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FORMATTING WORDART OBJECTS 

 Discussion 
The WordArt toolbar provides tools used to format WordArt objects. You can format a WordArt object by 
changing its font, font size, and attributes; modifying its style; altering its color, size, or position; changing its 
shape; adjusting its text height and alignment; or modifying its character spacing. 
 
You can edit WordArt objects using the following tools found on the WordArt toolbar: 

 
Button Name Button Function 
Insert WordArt 

 
Opens the WordArt Gallery dialog box; allows you to create a new 
WordArt object 

Edit Text Edit Text... Opens the Edit WordArt Text dialog box for editing WordArt text 

WordArt Gallery 
 

Opens the WordArt Gallery dialog box; allows you to select a 
different WordArt style 

Format WordArt 
 

Opens the Format WordArt dialog box for formatting the WordArt 
object 

WordArt Shape 
 

Allows you to select a different WordArt shape 

Text Wrapping 
 

Allows you to select a text-wrapping style 

WordArt Same 
Letter Heights  

Changes all the letters in the WordArt text to the same height 
within the defined shape 

WordArt Vertical 
Text  

Toggles the WordArt object between a vertical orientation and a 
horizontal orientation 

WordArt Alignment 
 

Allows you to select an alignment option 

WordArt Character 
Spacing  

Allows you to select a character spacing or kerning option 

 
 

  

 
If necessary, you can right-click the WordArt object and select the Show WordArt Toolbar 
command to display the WordArt toolbar. 

  

 
You can rotate WordArt by selecting the WordArt object, selecting the Draw button on the 
Drawing toolbar, pointing to the Rotate or Flip command, and selecting the desired rotation. You 
can then use the green rotate handle that appears on the WordArt object to rotate the object as 
desired. 
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 Procedures 

1. Select the WordArt object you want to modify. 

2. Click the desired button on the WordArt toolbar. 

3. Select the desired option, if necessary. 

 

USING ADVANCED LAYOUT OPTIONS 

 Discussion 
The Advanced Layout dialog box provides options for precisely positioning an object in a document, as well 
as for wrapping text around an object. 
 
The Picture Position page allows you to specify a horizontal and vertical position for a graphic object. 
Objects are positioned in relation to an anchor. The anchor options vary, but may include page, margin, 
paragraph, column, character, or line. You can specify an exact measurement in relation to the anchor or a 
relative position, such as the top or center. For example, you can specify that the object aligns to the right, 
relative to the margin. 
 
If you select a graphic and display the formatting marks, an anchor icon appears to the left of the line to which 
the graphic is anchored. If you want a graphic to move with its associated text, you can select the Move object 
with text option. The Lock anchor option guarantees that the object remains on the same page as the 
paragraph to which it is anchored, even if the object or the paragraph is moved. 
 
Wrapping text around an object gives a document a very professional appearance. Although there are several 
ways to apply text-wrapping options, the Text Wrapping page in the Advanced Layout dialog box provides 
all possible text-wrapping styles. In addition to selecting a text-wrapping style, you can control to which side 
of an object the text wraps, as well as specify the distance between the object and the text. 
 

  

 
You can also use the Text Wrapping button on the Picture or WordArt toolbar to select a text-
wrapping style. 

  

 
Only a picture with an Inline with text text-wrapping style can be viewed in Normal view. To view 
pictures with other text-wrapping styles, you must be in Print Layout or Web Layout view, or in 
print preview. 

  

 
The In line with text text-wrapping style positions a graphic object at the insertion point; 
consequently, no Picture Position options are available for this text-wrapping style. 
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 Procedures 

1. Right-click the graphic object you want to position. 

2. Select the Format WordArt command. 

3. Select the Layout tab. 

4. Select Advanced. 

5. Select the Text Wrapping tab. 

6. Under Wrapping style, select the desired wrapping style. 

7. Under Wrap text, select the side to which you want the text to wrap. 

8. Under Distance from text, enter the desired measurement. 

9. Select the Picture Position tab. 

10. Under Horizontal or Vertical, select the desired layout option. 

11. To define the selected layout option, select the first list to the right of it, if applicable. 

12. Select the desired position option. 

13. Select the second list to the right of the selected layout option, if applicable. 

14. Select the desired page option.  

15. Select and define additional options as desired. 

16. Under Options, select or deselect the desired settings. 

17. Select OK. 

18. Select OK. 

 

CREATING WATERMARKS 

 Discussion 
A watermark is a graphic or text that appears behind the text and objects on a page. Watermarks are commonly 
used to identify the status of a document (e.g., DRAFT). When a watermark is added to a page, it appears on 
all pages of the document or section. 
 
You can scale a picture watermark to increase or decrease its size. If you create a text watermark, you can 
select a text option from the Text list or type the text you wish to use into the Text box. You can also select 
the font, font size, color, and position of the text on the page. 
 
To be effective, the contrast and brightness of the watermark should be adjusted using either the Washout or 
Semitransparent options, so that the document text is legible. 
 
You can access the watermark image after it has been inserted by viewing the Header area. 
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Colors and fill effects available on the Background submenu on the Format menu are used in Web 
Layout view. These backgrounds are usually used to add interest to a document and are for viewing 
only, not printing. 

  

 
Selecting the Apply button in the Printed Watermark dialog box allows you to preview the 
watermark in your document. 

  
 

 Procedures 

1. Select the Format menu. 

2. Point to the Background command.  

3. Select the Printed Watermark command. 

4. To use a picture as a watermark, select the Picture watermark 
option. 

5. Select Select Picture. 

6. Select the Look in list. 

7. Select the drive containing the desired picture file. 

8. Open the folder containing the desired picture file. 

9. Select the name of the picture file you want to insert. 

10. Select Insert. 

11. Select OK. 
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using the Insert Clip Art task 
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Task panes 
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